
Lookup

Type here the word that you want to look up in the WordWeb database. 
When you have entered the word press Enter, or click on the Search button.



Previous Button

Press this button to look up the word that you last looked up.



Search Button

Press this button to look up the word in the Search Word edit box.



Show Nouns

Press this button to only show words that are nouns (or press Alt+N). 
If the button is disabled it means there is no sense in which the word is a noun.



Show Verbs

Press this button to only show words that are verbs (or press Alt+V). 
If the button is disabled it means there is no sense in which the word is a verb.



Show Adjectives

Press this button to only show words that are adjectives (or press Alt+A). 
If the button is disabled it means there is no sense in which the word is an adjective.



Show Adverbs

Press this button to only show words that are adverbs (or press Alt+R). 
If the button is disabled it means there is no sense in which the word is an adverb.



Sense descriptions

This box shows the different senses of the word you are looking up.
Different senses are numbered for each word type, nouns first, then verbs,
adjectives and adverbs.

See how to show synonyms by sense.



Showing synonyms by sense

Many words have more than one meaning, so when you lookup a word there many be more than one 
definition displayed. To show just the synonyms specific to a particular sense, just click on the sense 
number. Alternatively you can press TAB until the cursor appears in the sense section, use the cursor 
keys to move the cursor onto the sense you want to view, and press ENTER.

For example if the search word is diffuse then your sense list would be

Verb: diffuse
 1. move outward
 2. spread or diffuse through
 3. as of information

The synonyms include broadcast, disperse, spread out, permeate, etc. To show just the senses 
corresponding to move outward, click on the '1'. You will then only see the synonyms    fan out, spread 
out and spread.

Click another sense number to select a different sense, or click the selected number to show all the 
senses once again. The selected sense definition is shown in a different colour.



Showing synonyms by word type

The four buttons at the side of the definition box show whether the search word is a noun, verb, 
adjective, or adverb, the most common word types. A button is grayed if the search word does not have 
a meaning of that word type.

Click on one of the buttons to show only synonyms of that type, or use Alt+ the letter on the relevant 
button. Selecting a word type is also a good way to quickly view the definitions for that word type.

To show all the synonyms again (regardless of type) just click on the button again.



Showing related words

The tabs at the bottom of the synonyms list box show the different available types of related word. Just 
click on a tab to see words of that relationship, e.g. to see the antonyms of the search word click on the 
tab that says Antonyms (if no such tab is present it means there are no antonyms in the database). You 
can also see related words by pressing TAB until the tabs are selected and then using the cursor keys.

See Glossary of terms for explanation of the different types of related word.



Glossary of WordWeb terms

Synonyms Words which mean the same in some context
e.g. close is a synonym of shut.

Antonyms Words meaning the opposite in some context
e.g. big is an antonym of little

Attribs A noun for which the adjective expresses value
e.g. big is an attribute of size.

Type of Shows less specific words.
e.g. a comedy is a type of play

Types Shows more specific words.
e.g. flower has daisy as one of its types

Parts Shows words for part of an object
e.g. tree is one of the parts of a forest

Part of Shows words for a collection or the whole
e.g. bumper is a part of a car

Similar Words with meanings that are close
e.g. big is similar to huge

Copy

Press the copy button to copy the selected word to the clipboard. 

If there is selected text in the definition section then that will be copied,
otherwise the word selected in the list box. If you are running WordWeb 
from another program this button may close the window.



Close

Press this button to close the WordWeb window.



Tabs

Click on one of the tabs to show different sets of related words.
See glossary of terms for what the different words on the
tabs mean.



Synonyms list box

This show the synonyms of the search word, or other sets of related words indicated on the tabs at the 
top.

Click on a word and press the Copy button to copy a word to the clipboard (or if you are using WordWeb 
from a word processor to replace the looked-up word). Double click on an item in the list to look it up in 
the database. 

If WordWeb cannot match the part of speech of a word (for example if you look up plural noun WordWeb 
may not know how to pluralize the noun collocations that appear as synonyms) the word will appear with 
a star (*).



History list

Click on this to show the list of words previously searched for. 
You can press the up and down cursors to move quickly up and 
down the list without clicking this button. Press the Previous button
to return to the previous word.



Showing related words

WordWeb not only finds synonyms of words, but also a whole host of other words related in some way 
to the search word. The different types of relation are explained in the glossary of terms. 

When you first look up a word WordWeb displays the synonyms in the list box in the lower half of the 
window. The other types of related word available are show in the set of tabs at the top of the list box. 
Just click on one of these to show the related words of that type.



Options

There are three options on the Options menu - select one of them and a tick will appear by the menu to 
show that you have that option selected.

Show roots only

By default WordWeb displays synonyms in the same part of speech as the search word, e.g. if you 
search for hoped then it will display desired, expected, etc. If you select the Show roots only option it 
will display desire, expect, etc. The root of the search word found in the database is displayed in the 
sense descriptions. Select Show roots only to get the synonyms as they appear in the database. 

If WordWeb cannot match the part of speech of a word (for example if you look up plural noun WordWeb
may not know how to pluralize the noun collocations that appear as synonyms) the word will appear with
a start (*).

The WordWeb part of speech matcher is good, but not perfect (for instance it can’t tell the difference 
between collective nouns and ones that can be pluralized). If you want to be certain that you don’t 
accidentally misuse words select Show roots only.

Stay on top

Select this option to make the WordWeb window stay on top of other windows so that you can always 
see it.

Font

Select Small, Medium, or Large to change the font size used for showing definitions and synonyms.



Fonts

You can use WordWeb with three different font settings: small, medium and large. To change the font 
size just select Font from the Options menu, and select the one you want.



Resizing the WordWeb Window

You can resize the WordWeb window by dragging the bottom right corner with the mouse.

The size of the window is saved when you close WordWeb so that it will start up the same size next 
time.

If you change the window size you may also wish to change the window font.





Crossword Compiler – Make your own crosswords!

Crossword Compiler offers everything you need to make all kinds of crosswords, from simple educational 
puzzles to complex cryptic crosswords. It can fill in blank grids, generate vocabulary puzzles from a list of 
words, manage clues, print out, and lots, lots more! 

Add interactive crosswords to your web site!

Create vocabulary puzzles automatically

Automatic grid filling from word lists

Create many types of crossword in different languages

Clue editor (with optional link-up to WordWeb Pro)

Many export options for professional DTP

Visit the web page at http://www.x-word.com/ for more information.

Ordering Crossword Compiler

Order Online: http://www.x-word.com/ordering.html

Ordering in North America 

Ordering in Australia and New Zealand

Ordering in Europe (Euro orders) 

Ordering in the UK and elsewhere.

For up-to-date information see the web pages at http://www.x-word.com/ or email to compiler@x-
word.com



License Information

You may use WordWeb free of charge for whatever you like - I hope you enjoy the program.

The program is 'bannerware' - I let you use it for free in the hope that you may be interested in my other 
programs Crossword Compiler, WordWeb Pro and WordWeb Developer.

WordWeb may be freely distributed without royalty as long as it is distributed in the form of the original 
unmodified self-extracting installation program. For some distribution purposes the installation program 
may be zipped.

E-Mail: info@wordweb.co.uk
Internet: http://www.x-word.com/thesaurus/.

WordWeb is copyright © Antony Lewis 2000. All rights reserved.
WordNet database copyright 1997 © Princeton University. All rights reserved.

THIS SOFTWARE AND DATABASE IS PROVIDED "AS IS" AND PRINCETON    
UNIVERSITY MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR    
IMPLIED.    BY WAY OF EXAMPLE, BUT NOT LIMITATION, PRINCETON    
UNIVERSITY MAKES NO REPRESENTATIONS OR WARRANTIES OF MERCHANT-    
ABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE    
OF THE LICENSED SOFTWARE, DATABASE OR DOCUMENTATION WILL NOT    
INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR    
OTHER RIGHTS.



WordWeb Pro

WordWeb Pro offers some great extra features:

Word searching facility
Enter a pattern as the search word and it will find words that match, e.g.

T???SH finds thrash, thresh and thrush
*GRY finds angry, hungry and unangry
?*Q*P finds acquaintanceship, equip, liquid soap, re-equip, 

and square up

Use * to stand for any number of letters, ? for one unknown letter, @ for any vowel or # for a 
consonant. You can also search for letter groups and do punctuation-sensitive searches. The huge 
160,000 word database is searched very quickly.

Anagrams
Enter a word and you can find all straight and multiple word anagrams, e.g.

protest finds potters, spotter, to strep, pert sot, etc.
begin finds being, binge, in beg, and gin be.
WordWeb Pro finds powder brow + many others

Customize the dictionary
Add to and edit the dictionary. Add new words, add new senses, edit definitions, etc.

WordWeb Pro can also be integrated into Crossword Compiler if you wish to write crosswords.

Buy it now!

WordWeb Pro costs just $18 US Dollars ($25 on CD-ROM). You can view the price in your local currency 
by going to the ordering page where you can also

Order Online:    http://www.wordweb.co.uk/ordering.html.

Paying in US Dollars - $18 ($25 on CD-ROM).

The program costs $18 (download instructions sent to your e-mail address) or add $7 for a CD-ROM by 
mail.

You can order from ShareIt! Inc. by credit card, check or purchase order in the following ways:

Phone:    1-800-903-4152 or (724) 850-8186 
FAX: (724) 850-8187
Mail: ShareIt! Inc, PO Box 844, Greensburg, PA 15601-0844, USA

Please ask for product number 130377 when you order

Paying in Pounds Sterling - £12 (£15 on CD-ROM)

Print out an order form that you can fill in and post. 



Payment is by cheque, Eurocheque or money order. If you don't have a Sterling cheque account you can 
also pay by non-Sterling cheque for an equivalent amount plus a £4 handling charge. Alternatively use 
one of the methods listed above under Paying in US dollars.

Paying in Euros – 18    (25 on CD-ROM).

The program costs 18 Euros (download instructions sent to your e-mail address) or add 7 Euros for a CD-
ROM by mail.

You can order from ShareIt! in Germany by credit card, check or purchase order in the following ways:

Phone:    +49-221-31088-20
FAX: +49-221 -31088-29
Mail:    ShareIt! element 5 AG, Vogelsanger Strasse 78, 50823 Koeln, Germany

Please ask for product number 130377 when you order

Paying in Australian Dollars – A$39 on CD-ROM

You can order by phone, fax, email, postal mail or online.

Fax your order to (02) 9565-2362
Phone your order to (02) 9565-2339
Email your order to sales@shareware-australia.com
Mail your order to: Shareware-Australia, PO Box 1075, Maroubra NSW 2035

Payment can be made by Cheque, Money Order, Bankcard, Mastercard, Visacard, or American Express.

Other methods of payment and inquiries

Please e-mail any questions to ordering@wordweb.co.uk
Up to date information about WordWeb Pro can be found on the World Wide Web at 
http://www.wordweb.co.uk/.



Crossword Compiler 5 Order Form

Select Print Topic... from the File menu and fill in the form to order by post. 

Name:

Company name:

Address:

Your email address:
(This MUST be given unless you 
pay the P&P for shipping a CD-ROM)

Where did you hear about WordWeb?

Item Price Quantity Subtotal
Crossword Compiler £28 _______ _______
WordWeb Pro thesaurus/dictionary £15 _______ _______
Additional word lists £12 _______ _______
UK word lists £6 _______ _______

Language word lists £6 _______ _______
Crossword Compiler Bundle 
(all of the above)

£55 _______ _______

Professional Grid Filler £59 _______ _______

Professional Bundle (all of the above) £89 _______ _______

Postage and Packing:
(If you want a CD-ROM by mail)

£5 _______

Total: _______

Please make cheques payable to Antony Lewis and mail to:

Antony Lewis, 4 St. Mark’s Court, Cambridge CB3 9LE, UK.



Ordering Crossword Compiler in N. America

Order Online

You can pay by credit card and download the full program immediately (or order the CD-ROM by mail). 

Follow the links from http://www.x-word.com/ordering.html. 

Phone, FAX and mail orders

The following combinations are available from ShareIt! Inc.

(#106786) Crossword Compiler $45

(#106787) Crossword Compiler Bundle $89

(#106789) Crossword Compiler Professional $144

(#106790) Crossword Compiler Professional Bundle $159

The Bundle options include WordWeb Pro and all the optional word lists. The Professional options include
the Professional Grid Filler (powerful grid filling with complete control over which words are used).

Please add $15 if you would like a CD-ROM sent by mail, otherwise download instructions will be sent to 
your e-mail address.

You can order from ShareIt! Inc. by credit card, check or purchase order in the following ways:

Phone:    1-800-903-4152 or (724) 850-8186 

FAX or Mail:    Print out, fill in and send this order form

Please quote the product number given above when you order.

THESE DETAILS ARE FOR ORDERS ONLY. 

Please e-mail any questions to ordering@x-word.com. Up to date information about the program can also
be found on the Internet at http://www.x-word.com.

Optional word lists

Additional word lists.
Compound words and phrases. Words and expressions from Webster's second edition. Medical, legal, 
and ethnic words. Movies and literature. Lists of names, cities and US places. Large list of unusual words 
and variant spellings. 

Language word lists
Danish, Dutch, Finnish, French, German, Icelandic, Italian, Russian, Latin, Norwegian, Spanish, Swedish

UK word lists
UK Advanced Cryptics Dictionary (large list of 200,000+ words and compounds), UK place names, 
Scottish and RAF words.



Using WordWeb

Click on a part of the window to see a description of what it does, or select one of the following topics:

Showing synonyms by sense

Showing synonyms by word type

Showing other related words



WordWeb Developer

WordWeb Developer contains two thesaurus/dictionary components for Delphi or C++ Builder. One is 
very similar to WordWeb, just minus the menu bar. The other is a cut-down thesaurus only, useful 
because it can be used with a much smaller database file. The full database is exactly the same as the 
one used by WordWeb.

Highlights:

Two easy-to-use components
Large up-to-date database
Database customizer
Full source code for direct low-level database access
Works with Delphi    and C++ Builder

Database customizer:

Add to and edit the database
Create smaller databases containing a subset of the original (sizes from <1MB to >6MB)
Remove a custom list of words from the database

For up-to-date information see the web pages at http://www.x-word.com/wwdev/. There may become 
available versions for other programming environments - please check the web pages.

Ordering

Order online at http://www.x-word.com/wwdev/ordering.html.

Please e-mail any questions to wordweb@x-word.com.



Ordering Crossword Compiler in Australia and New Zealand

Crossword Compiler is available in Australia/New Zealand from our local distributor Shareware-Australia. 
You may also wish to order online in US dollars – follow the links from 
http://www.x-word.com/ordering.html for details.

The following are available (prices in Australian dollars):

Crossword Compiler $79

Crossword Compiler Bundle

(includes lots of extra word lists and WordWeb Pro )

$149

Professional Grid Filler

(optional add-on for either of the above)

$159

You can order by phone, fax, email, postal mail or online.

Fax your order to (02) 9565-2362
Phone your order to (02) 9565-2339
Email your order to sales@shareware-australia.com
Mail your order to: Shareware-Australia, PO Box 1075, Maroubra NSW 2035

Payment can be made by Cheque, Money Order, Bankcard, Mastercard, Visacard, or American Express.

There is an order form that you can print out and send.

The extra word lists

Additional word lists.
Compound words and phrases. Words and expressions from Webster's second edition. Medical, legal, 
and ethnic words. Movies and literature. Lists of names, cities and US places. Large list of unusual words 
and variant spellings. 

Language word lists
Danish, Dutch, Finnish, French, German, Icelandic, Italian, Russian, Latin, Norwegian, Spanish, Swedish

UK word lists
UK Advanced Cryptics Dictionary (large list of 200,000+ words and compounds), UK place names, 
Scottish and RAF words.



Crossword Compiler Order Form

Select Print Topic from the file menu, fill in the form and mail your 
order to: 

Shareware-Australia, PO Box 1075, Maroubra NSW 2035, Australia

Payment can be made by Cheque, Money Order, Bankcard, Mastercard, 
Visacard, or American Express.

Name:___________________________________________________________________

Address: _______________________________________________________________

         _______________________________________________________________

Phone: ____________Fax: ____________ Email: ____________________________

Paid by Cheque/Money Order [ ]  Credit Card [ ]

Credit Card No. _________________________________________________________

Expiry Date: __________  Signature: _____________________________________

Please supply

__ copies of Crossword Compiler @ AU$ 79.00 each $______

__ copies of Crossword Compiler Bundle  @ AU$ 149.00 each $______
__ copies of Professional Grid Filler @ AU$ 159.00 each $______

Postage & Handling @ AU$ 20
(Not applicable for delivery by e-mail) $______

Total $______

Deliver by Post [ ]   e-mail [  ]



WordWeb Pro 1.63 Order Form

Select Print Topic... from the File menu and fill in the form to order by post.

Name:

Address: 

Your email address:
(This MUST be given unless you 
pay the P&P for shipping a CD-ROM)

Where did you get your copy of WordWeb from? 

Item Price Quantity Subtotal
WordWeb Pro £12 _______ _______

Postage and Packing:
(If you want a CD-ROM by mail)

£3 _______

Total: _______

Please make cheques payable to Antony Lewis and mail to:

Antony Lewis, 4 St. Mark’s Court, Cambridge CB3 9LE, UK.



Crossword Compiler Order Form

Select Print Topic from the file menu to print out the form.

Your name:

Company name:

Address:

FAX: Phone:

Your email address:
(This MUST be given unless you pay 
the S&H for shipping a CD-ROM)

Product Name Price Number Subtotal

106786 Crossword Compiler $45 ______ ______

106787 Crossword Compiler Bundle $89 ______ ______

106789 Crossword Compiler Professional $144 ______ ______

106790 Crossword Compiler Professional Bundle $159 ______ ______
Shipping and Handling
(Not applicable for e-mail delivery) $15 ______

Total: ______

How would like to receive the full version?    e-mail: [    ]    postal mail: [    ]

How would you like to pay?    credit card: [    ]    check: [    ]    purchase order: [    ]

Credit card information (if applicable)

Credit card: Visa: [    ]    Eurocard/Mastercard: [    ]    American Express: [    ]    Diners Club: [    ]

Card holder: ________________________________

Card No.: ___________________________________ Expiration Date: ________

Date / Signature: ___________________________

Please FAX to ShareIt! Inc at (724) 850-8187 or mail to

ShareIt! Inc, PO Box 844, Greensburg, PA 15601-0844, USA





Ordering Crossword Compiler in Euros

You can order online in Euros, see http://www.x-word.com/ordering.html for details. 

The following are available from ShareIt, with prices in Euros:

(#106786) Crossword Compiler 45

(#106787) Crossword Compiler Bundle 89

(#106789) Crossword Compiler Professional 144

(#106790) Crossword Compiler Professional Bundle 159

The Bundle options include all the extra word lists (see below) and WordWeb Pro, the Professional 
options include the Professional Grid Filler.

Add 15 Euros P&P if you would like a CD-ROM by mail, otherwise download instructions will be sent to 
your e-mail address.

Please quote the product number above when you order. Mail to

element 5 AG / ShareIt!
Vogelsanger Strasse 78
50823 Koeln
Germany

or

Phone: +49 -221-31088-20
Fax:    +49 -221-31088-29
E-Mail:    register@shareit.com



Technical Information

WordWeb works through a Windows DLL that you can use from other applications By calling 
procedures in the DLL you can pop up the WordWeb box from other programs.

If you wish to use WordWeb from your wordprocessor, say, you could write a macro to call the DLL 
functions to display the synonyms of the word you have selected in the wordprocessor. See the Using 
WordWeb from your word processor topic for how to use these. If you write a macro for other programs I
would be happy to add them to future versions of WordWeb.

Programmers: Look at http://www.x-word.com/wwdev on the Internet for details of WordWeb Developer.

For the programmers amongst you, here’s what the Borland Pascal/Delphi declarations for the DLL API 
look like in case you want to write your own macros:

function ShowWordWeb(P:PChar; AParent:Integer):integer; {index 1}

Shows WordWeb with P as the search word, AParent as the parent window. If P is nil then WordWeb is 
not initialized with any search word. Returns a handle to the WordWeb window. You must have AParent 
non-zero or retain the return handle. It will then either close when you close AParent or, in the second 
case, you can send it a message to close it.

function ShowModalWordWeb(InP,OutP:PChar; CloseOnCopy:Boolean; AParent:Integer): 
Boolean; {index 2}

Shows WordWeb modally - i.e. it shows the window but waits for the window to close before returning. 
InP functions the same as P in ShowWordWeb. OutP points to a buffer to contain any selected word 
(the buffer should be 255 bytes long). CloseOnCopy determines whether the function returns with the 
selected word when the user presses the copy button. If this is true, pressing Copy closes the window, 
OutP contains the selected word and the function returns true. If WordWeb is closed by pressing Close 
the function returns false.



Using WordWeb from your word processor

WordWeb can be used directly from some word processors. You just run a macro, which pops up 
WordWeb showing synonyms for the currently selected word in your word processor. Pressing Copy 
then replaces the word with the word you selected in WordWeb. 

Using WordWeb from MS Word (95, 97, 2000 or above)

This will be done automatically if you select this option in the installation program.

Copy the template file supplied with WordWeb to your Word startup folder. For Word 95 this is called 
WORDWEB, for Word 97 and above it's called WWebVB. Find them in the folder to which you installed 
WordWeb. 

You can find where your Word startup folder is by opening Word, selecting Options from the Tools 
menu and changing to the File Locations tab. 

Once you've copied the template, just start Word and click on the button on the toolbar to show 
WordWeb. Alternatively use the Alt+Ctrl+W keyboard shortcut, or look for the WordWeb... item on the 
Tools menu. If the WordWeb toolbar does not appear try right clicking on the the toolbar and making 
sure that the WordWeb item is selected to be visible.

Using WordWeb from Corel WordPerfect 7

You can use WordWeb from WordPerfect by using the WWebUK.wcm or WWebUS.wcm PerfectScript 
macros supplied with WordWeb. If you are using the UK version then use the WWebUK.wcm macro, if 
the US version use the WWebUS.wcm macro. To run the macro just select Tools | Macro | Play...,    and 
open the macro file. You can also assign the macro to a button or menu if you like — see the 
WordPerfect Help for more information.

Observant users may notice a remarkable similarity between the data in WordWeb and the WordPerfect 
thesaurus. The programs themselves are however quite different - I only discovered the ‘similarity’ by 
accident!

Using WordWeb from Lotus WordPro

You can use WordWeb from WordPro by using the WordWeb.LSS LotusScript file supplied with 
WordWeb. To show WordWeb just select Edit | Script & Macros | Run... and click Browse to open the 
WordWeb.LSS script.    You need WWEB32.DLL to use WordWeb from WordPro 96.

If you like you can assign the script to a tool button and save the script in your default WordPro 
document so that you can always use WordWeb with the click of a button. See the WordPro help for 
details of how to do this.




